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Popisná statistika bodových Popisná statistika bodových 
objektůobjektů  

• Charakteristiky polohy 

• Charakteristiky rozptylu 

• Charakteristiky asymetrie 

• Charakteristiky špičatosti 



Charakteristiky polohyCharakteristiky polohy  

• Průměrný střed (mean center) 

• Vážený průměrný střed (weighted mean 
center) 

• Agregovaný průměrný střed 

• Mediánový střed (median center) 



Průměrný středPrůměrný střed  

• Průměrný střed leží na průměru souřadnic X a Y. 

• Vzorec: 
– Xprůměr = Součet hodnot X souřadnic všech bodů / počet bodů 

– Yprůměr = Součet hodnot Y souřadnic všech bodů / počet bodů 

 

• Má stejné nevýhody jako aritmetický průměr – je 
to především citlivost na extrémní hodnoty. 
– Například v případě shlukového uspořádání bodů průměrný střed 

dobře nereprezentuje množinu bodů 

 

Rozčlenění bodů 
na kategorie 



Příklad Příklad   

The mean center and media 
center of fire stations in Austin, 
Texas. Note that some fire 
stations are in the Austin 
extraterritorialjurisdiction (ETJ) 
area, and therefore are located 
outside of the city boundary. 
Data source: 
data.AustinTexas.gov 



Vážený průměrný středVážený průměrný střed  

 

 
• Používá se v případě výskytu více událostí/objektů 

na stejném místě. 

• Pak má každý bod váhu přímo úměrnou počtu 
událostí/objektů na tomto místě. 

• Např.: při výpočtu prostorového průměru několika 
měst bude průměrný střed dávat realističtější 
představu o centrální tendenci, 
jestliže ho budeme vážit  
počtem obyvatel  
jednotlivých měst 



Příklad Příklad   



Mediánový středMediánový střed  

 

 

a) najdeme medián na ose X a Y a vedeme z nich linie kolmé na směr 
osy. Takto definovaný „medián ze souřadnic“ ale nemusí odpovídat 
mediánu souboru bodů, protože distribuce nemusí být mezi 
kvadranty vyrovnaná. 

b) (UK): Mediánový střed je střed, kterým se studovaná plocha dělí 
do čtyř kvadrantů, z nichž každý obsahuje stejný počet bodů. 

c) (US): Mediánový střed jako střed vyžadující minimální (nejkratší) 
cestu. Tj. celková vzdálenost z mediánového středu do každého z 
bodů je minimální. Jinak řečeno – cesta z jakéhokoliv jiného místa 
do všech bodů oblasti bude delší než cesta z mediánového středu.  

ArcGIS Pro: 

Identifies the 

location that 

minimizes overall 

Euclidean distance 

to the features in a 

dataset. 



Vlastnosti charakteristik polohyVlastnosti charakteristik polohy  

• Průměrný střed minimalizuje sumu čtverců vzdáleností 

• Mediánový střed minimalizuje sumu vzdáleností – jeho 
interpretace je jednodušší 

• Nejčastěji se využívá váženého mediánového středu 
(demografie) 

– Př.: srovnání vývoje osídlení v čase  

• Charakteristiky polohy bez uvedení charakteristik 
rozptylu mají malou vypovídací schopnost a mohou být 
zavádějící 



Charakteristiky rozptyluCharakteristiky rozptylu  

• Směrodatná vzdálenost (standard 
distance circle) 

• Vážená směrodatná vzdálenost (weighted 
standard distance) 

• Koeficient relativního rozptylu (coefficient 
of relative dispersion) 

• Směrodatná elipsa odchylek (standard 
deviational ellipse) 

 



Směrodatná vzdálenostSměrodatná vzdálenost  

• Směrodatná vzdálenost je nejčastěji používána ve formě 
kružnice kolem průměrného středu (Standard distance 
circle), jejíž poloměr je právě hodnota směrodatné 
vzdálenosti. 

• Tyto kružnice nám dávají představu o rozptylu hodnot 
kolem střední hodnoty pro jednotlivé typy jevů. 

• Mohou být použity i pro studium dynamiky jevů  
(př.: různé kružnice pro jeden  
jev v různých časových  
horizontech) 

 

A polygon feature class that 
will contain a circle polygon for 
each input center. These circle 
polygons graphically portray 
the standard distance at each 
center point. 



Směrodatná vzdálenostSměrodatná vzdálenost  

• Mohou být použity i pro studium dynamiky jevů 

– př.: různé kružnice pro jeden jev v různých časových 
horizontech 

• Směrodatná vzdálenost (standard distance) je 
absolutní mírou – je problematické její použití k 
porovnání několika souborů 

• Vhodnější jsou míry relativní 

 

Vážená směrodatná vzdálenostVážená směrodatná vzdálenost  



Koeficient relativního rozptyluKoeficient relativního rozptylu  

• Poměr směrodatné vzdálenosti a poloměru kruhu se 
stejnou plochou jakou má studovaná oblast. 

• Řeší problém použití absolutní míry směrodatné 
vzdálenosti. 

• Je-li oblast různě velká (ohraničená), vznikají zavádějící 
hodnoty. 

• K získání relativní míry při studiu variability obyvatelstva 
se někdy používá poloměr země nebo státu místo 
poloměru kruhu se stejnou plochou jakou má studovaná 
oblast. 

 

poloměr z plochy kruhu:   R = √ (P/π) 



Směrodatná elipsa odchylekSměrodatná elipsa odchylek  

• V mnoha případech může vykazovat prostorové 
rozdělení jevů určité rysy směrovosti (directional bias), 
např.:  

– rozdělení míst nejčastějších dopravních nehod podél 
dálnice. 

• V tomto případě se použití kružnice jako míry rozptylu 
hodnot jeví jako nevhodné. 

• Jako logické rozšíření směrodatné kružnice odchylek se 
může jevit použití směrodatné elipsy odchylek. Tuto 
elipsu popisují tři atributy: 

– úhel rotace 

– směrodatná odchylka podél hlavní osy elipsy 

– směrodatná odchylka podél vedlejší osy elipsy 

• Maximální rozptyl bude orientován v souladu s hlavní 
osou elipsy. 

 



Směrodatná elipsa odchylekSměrodatná elipsa odchylek  

• Př.:  

– Množství kontaminující látky ve vzorku studní může 
indikovat trend jejích šíření 

– Porovnání velikosti, tvaru resp. překryvu elips k 
porovnání změn v rozšiřování etnik či rostlinných 
resp. živočišných společenstev 

– Epidemiologie – vystižení hlavního trendu šíření 
onemocnění v populaci 

 



Příklad Příklad   

Standard deviation ellipse 
created based on Austin fire 
station locations 
Data source: 
data.AustinTexas.gov 



Poznámky k deskripci bodůPoznámky k deskripci bodů  

• hustota bodů v ploše (počet/plocha = n/R), 

• charakteristiky založené na vzdálenosti mezi body či na 
relativních vzdálenostech jako je např. di/dmax. 

• použití – porovnávání (např. v čase) 

• při výpočtech v relativně malých oblastech používáme 
euklidovskou geometrii, protože se v nich neprojeví 
zakřivení Země. 

• uvedené míry mohou být aplikovány i na plochy. 

– Jakým způsobem?  

 



Základní metody statistického popisu Základní metody statistického popisu 
prostorového uspořádání bodůprostorového uspořádání bodů  

• Analýza kvadrátů – testujeme, zda 
rozmístění bodů v ploše je náhodné či nikoliv. 

 

• Metoda nejbližšího souseda – porovnává 
průměrnou vzdálenost mezi nejbližšími 
sousedy pole bodů k teoretickému rozmístění. 

 

• Prostorová autokorelace – měří jak podobné 
či nepodobné jsou hodnoty atributů sousedních 
bodů. 



Metody statistického popisu bodů Metody statistického popisu bodů ––  
obecně obecně   

• Rozmístění bodů v prostoru je výsledkem určitých 
procesů či vhodných podmínek (lokace měst je 
výsledkem působení faktorů jako reliéf, přírodní zdroje, 
komunikace, atd.) 

• Cílem studia prostorového rozmístění bodů je zjistit: 

– jak daleko má konkrétní rozmístění objektů k rozmístění 
teoretickému 

– jak se liší rozmístění bodů ve dvou různých oblastech 

– jak se mění rozmístění bodů v rámci jedné oblasti v čase. 

• Statisticky prokázaný výskyt určitého prostorového 
uspořádání může být základem pro zjišťování příčin, 
které vedly k pozorovanému uspořádání. 

• Problémy:  

– měřítko 

– rozsah studované oblasti 

– kartografická projekce 



Analýza kvadrátů Analýza kvadrátů   

• Je založena na hodnocení změn hustoty bodů v prostoru. 

• Je porovnáváno, zda rozmístění bodů v prostoru je 
náhodné, či má blíže k uspořádání shlukovému či 
pravidelnému. 

• Studovaná plocha je rozdělena pravidelnou sítí na buňky 
a je zjištěn počet bodů v každé buňce. 



Analýza kvadrátů Analýza kvadrátů   

• Je analyzováno rozdělení četností buněk s určitým 
počtem bodů. 

• Toto rozdělení je porovnáváno s náhodným rozdělením 
četností. 

– Extrémně shlukové uspořádání – většina bodů v 
jedné či několika málo buňkách. 

– Extrémně pravidelné – ve všech buňkách přibližně 
stejně 

• Buňky se označují jako kvadráty a nemusí jít o čtverce, 
ale např. i o kruhy či šestiúhelníky – je to dáno empirií. 

• V rámci jedné analýzy však tvar a velikost buněk musí 
být konstantní. 



Analýza kvadrátů Analýza kvadrátů   

• Optimalní velikost kvadrátů (QS) 

– QS = (2*A)/n 

 

– A - plocha studované oblasti 

– n - počet analyzovaných bodů. 

 

• Velikost strany vhodného kvadrátu 

– √(2A/n) 

Study area has been divided into 4*5 
uniformly shaped quadrats of 81 km2, and 

the top left quadrat has a density of 1/81. 



Analýza kvadrátů Analýza kvadrátů   

Materiály předmětu 
Z6101 Základy 
geostatistiky 



Metoda nejbližšího sousedaMetoda nejbližšího souseda  

• NEAREST NEIGHBOUR ANALYSIS 

• Metoda analýzy kvadrátů je založena na 
konceptu hustoty (počet bodů v ploše) 

• Metoda analýzy nejbližšího souseda je 
naopak založena na konceptu vzdálenosti 
(spacing – plocha připadající na bod). 

• Metoda analýzy nejbližšího souseda je založena 
na porovnání pozorované průměrné 
vzdálenosti mezi nejbližšími sousedy a této 
průměrné vzdálenosti u známého 
(teoretického) prostorového uspořádání 
(pravidelného či náhodného). 



Metoda nejbližšího sousedaMetoda nejbližšího souseda  



Metoda nejbližšího sousedaMetoda nejbližšího souseda  

• NEAREST NEIGHBOUR ANALYSIS 

• Metoda analýzy kvadrátů je založena na 
konceptu hustoty (počet bodů v ploše) 

• Metoda analýzy nejbližšího souseda je 
naopak založena na konceptu vzdálenosti 
(spacing – plocha připadající na bod). 

• Metoda analýzy nejbližšího souseda je založena 
na porovnání pozorované průměrné 
vzdálenosti mezi nejbližšími sousedy a této 
průměrné vzdálenosti u známého 
(teoretického) prostorového uspořádání 
(pravidelného či náhodného). 



Metoda nejbližšího sousedaMetoda nejbližšího souseda  

• NEAREST NEIGHBOUR ANALYSIS 

• Metoda analýzy kvadrátů je založena na konceptu 
hustoty (počet bodů v ploše) 

• Metoda analýzy nejbližšího souseda je naopak 
založena na konceptu vzdálenosti (spacing – plocha 
připadající na bod). 

• Metoda analýzy nejbližšího souseda je založena na 
porovnání pozorované průměrné vzdálenosti mezi 
nejbližšími sousedy a této průměrné vzdálenosti u 
známého (teoretického) prostorového uspořádání 
(pravidelného či náhodného). 

• K testováni, zda má určité rozloženi bodů v ploše 
jistý vzorek lze využit R statistiku (R - 
randomness). 

 



Metoda nejbližšího sousedaMetoda nejbližšího souseda  

• … 



Metoda nejbližšího sousedaMetoda nejbližšího souseda  



Metoda nejbližšího sousedaMetoda nejbližšího souseda  

• Nelze spolehat na vizualni srovnani prostoroveho rozloženi ani 
na vypočtenou hodnotu R. Ta by měla byt doplněna hodnotou 
ZR (Z skóre) pro ověřeni statistické významnosti pozorovaného 
rozdílu. 

• Výsledky jsou vysoce citlivé k měřítku (lokální vs. regionální) 

• V zavislosti na studovanem jevu musi byt věnovana pozornost 
vymezeni studované plochy (administrativní či přirozené 
hranice). 



Prostorová autokorelace Prostorová autokorelace ––  koncepce  koncepce    

• Jak analýza kvadrátů tak analýza vzdálenosti 
nejbližšího souseda pracují pouze s polohou bodů. 

• Nerozlišují body podle hodnot jejich atributů. 

• Oba parametry (polohu i atributy) hodnotí 
prostorová autokorelace (SA) – je tedy metodou 
vhodnější. 

• Východiska prostorové autokorelace: Většina jevů 
se v prostoru mění spojitě. Blízké body budou mít i 
podobné hodnoty studovaného jevu a naopak. 

– First law of geography – Tobler (1970) 



Prostorová autokorelace Prostorová autokorelace   

• Mezi nejpoužívanější koeficienty prostorové 
autokorelace náleží: 

– Gearyho poměr C (Geary’s Ratio) 

– Moranův index I (Moran’s I) 

• Lze jich využít pro intervalová a poměrová data. 



Prostorová autokorelace Prostorová autokorelace   



Metoda jádrových odhadůMetoda jádrových odhadů  

• Hlavní metodou pro identifikaci anomálních lokalit, které bývají 
často nazývány jako hot spots, je metoda jádrových 
odhadů (kernel density estimation) či jádrového vyhlazení.  

 
• Jaká je hlavní nevýhoda?? 

– Základním nedostatkem je subjektivita v intepretaci 
výsledků.  

– Stejná podkladová data mohou být zobrazena značně 
rozdílně jen s využitím rozdílného nastavení metody a 
způsobu zobrazení.  

• Použité parametry je vhodné uvést. 

– Z tohoto důvodu je potřeba zvýraznit statisticky významné 
výsledky.  



Metoda jádrových odhadůMetoda jádrových odhadů  

 



Předpoklady užití metodyPředpoklady užití metody  

• Není vhodná pro zobrazení rozsáhlých území. 

• Vhodná pro mapy větších měřítek (obce či jejich 
části).  

• Není doporučena pro větší územní celky (okres, 
kraj, ČR)  toto záleží na zobrazovaném jevu 

• Neexistuje také žádná hranice pro minimální počet 
událostí v oblasti.  

• Doporučujeme však brát v potaz počet bodů a 
plochu analyzované oblasti. Pokud je oblast menší, 
je možné pracovat i s menším počtem událostí.  

• V případě malých počtů na větší ploše použití 
jádrového vyhlazení není doporučeno.  



Krok I Krok I ––  
PŘEDZPRACOVÁNÍ DAT PŘEDZPRACOVÁNÍ DAT   

• Základní podmínkou - kvalitní data.  

• Nutné se zaměřit na: 

– správnost a přesnost souřadnicového určení polohy,  

– časové určení, 

– tematické určení.  

• Rozlišit případy, kdy již záznam deliktu obsahuje 
souřadnice, od těch, kde je poloha vyjádřena pouze 
adresou či jiným referencováním.  

• Pokud jsou body lokalizovány na jedno místo, tak zde 
vznikají umělé shluky, které mylně identifikují lokalitu 
jako anomální.  

– Řešení – náhodné rozmístění událostí podél/uvnitř 
lokalizovaného objektu.  

 



Krok II Krok II ––  VOLBA METODY VOLBA METODY   
    

• KDE? v celé ploše území vs výskyt omezen pouze na jisté části 
území.  

• jádrové odhady plošné (2D) a jednorozměrné (1D), modelující 
výskyt pouze na liniích. 

• Obecně metoda jádrových odhadů přiřazuje každému bodu v mapě 
odhad intenzity na základě vzdálenosti k ostatním událostem. 
Nemůžeme však tuto intenzitu počítat pro každý bod, jelikož těch je 
nekonečně mnoho, a tak je analyzované území proloženo čtvercovým 
gridem a intenzity jsou počítány pro centroidy jednotlivých buněk.   

• V prvním kroku je potřeba vybrat metodu jádrového odhadu:  

– Jednoduchý 

– Duální 

• Dále je nutné volit mezi jádrovým odhadem s dosahem: 

– Fixní 

– Adaptivní 



  
Krok III Krok III ––    

NASTAVENÍ VYHLAZOVACÍ FUNKCENASTAVENÍ VYHLAZOVACÍ FUNKCE  

• šest různých vyhlazovacích funkcí: normální, 
rovnoměrná, kvartická, kuželová, kvadratická a 
záporná exponenciální.  

• nejčastěji se využívá kvartická funkce,  



Závislost na zvolené Závislost na zvolené 
vyhlazovací funkcivyhlazovací funkci  

Trojúhelníková vs. Gausova (normální) 



Velikost buňkyVelikost buňky  

• GRID = nezbytné správně zvolit jeho prostorové 
rozlišení.  

• Velikost buňky tohoto gridu ovlivňuje získané 
výsledky z pohledu detailnosti a také velikosti 
souboru.  

• nehraje na přesnost výsledků tak důležitou roli, 
jako další dva parametry. 

• Jak stanovit?   

– MBR (kratší strana/150). 

– ČR – města a obce velikost buňky 50 m, 
minimum 10 m. 

– Výjimky? 



Dosah (šířka pásma) Dosah (šířka pásma)   
  

• Pro výsledky jádrových odhadů je klíčová především volba 

dosahu vyhlazovací funkce. Neexistuje žádné obecné 

pravidlo, jak určit nejvhodnější hodnotu dosahu.  

• Vždy záleží na prostorové distribuci bodů, typu události a 

měřítku – závislost dosahu konkrétního trestného činu. 

• Explorace (vývoj území) vs. Identifikace anomálií (hot 

spots). 



GIS4SG 

50 – 200 – 400 m rozsah 

Dvoustupňová analýza 
Adaptivní dosah 



Krok IV Krok IV --    
PROVĚŘENÍ STATISTICKÉ VÝZNAMNOSTI PROVĚŘENÍ STATISTICKÉ VÝZNAMNOSTI   

• Výstup = grid s intenzitami událostí, sám o sobě 
neposkytuje informaci o výskytu statisticky 
významných oblastí a jeho interpretace je velmi 
subjektivní.  

• Nejpoužívanějším postupem pro hodnocení výsledků 
jádrových odhadů je Getis-Ord Gi* index. 

• Pro výpočet Gi* doporučeno použít topologické okolí 
definované pohybem královny prvního řádu. 
Doporučujeme zobrazit jen statisticky významné 
výsledky na hladině významnosti nejméně 95 %.  

• Následně hranici těchto významných shluků 
zobrazit spolu s výsledky jádrového vyhlazení a 
vyznačit v tomto výstupu hranice těchto statisticky 
významných anomálních oblastí.  



GetisGetis--OrdOrd  GI* GI*   

• Ukazatel významnosti shluku. 

• Gi* statistika vrací pro každý prvek v datové 
sadě tzv. Z skóre (z-score).  

• Statisticky významné pozitivní z-score = čím 
větší, tím je intenzivnější shluk vysokých hodnot 
(hot spot). 

• Statisticky významné negativní Z skóre = čím 
menší Z skóre, tím intenzivnější shluk nízkých 
hodnot (cold spot). 



GI a GI* statistikaGI a GI* statistika  

• Každá buňka má 
jednoznačnou hodnotu. 

• Nulová hypotéza: 

• Není žádný vztah 
mezi hodnotami 
počtu trestných činů 
v buňce a v jejím 
okolí, a to až do 
vzdálenosti d měřené 
ve všech směrech. 
Srovnáno se sumou 
hodnot na celém 
studovaném území. 

 



GI a GI* statistikaGI a GI* statistika  

Srovnání lokálního s globálním 

• Existuje lokální prostorová asociace? 

• Hodně vysokých hodnot v blízkosti buňky.  

– Gi* hodnoty budou pozitivní pro všechny buňky 

• Hodně nízkých hodnot pohromadě 

– Gi* hodnoty budou negativní pro všechny buňky 

 

• Příklad: Pro hodnotu 9 v centru vzorku platí: 

– Gi* value = 4.1785 

– Gi* hodnota je pozitivní 

• V relativním porovnání  
(lokální vs. globální)  
se jedná o hodně buněk  
s vysokou hodnotou jevu.  

 



GI a GI* statistikaGI a GI* statistika  

• Gi* výsledky jsou Z skóre  

• Z skóre indikují umístění dané hodnoty v datové 
sadě  vzhledem k průměru, standardizované s 
ohledem na směrodatnou odchylku (standard 
deviation).  

– Z = 0  odpovídá průměru 

– Z < 0 méně než průměr 

– Z > 0  

 

• Z skóre používáno pro určení prahu spolehlivosti a 
zhodnocení statistické významnosti.  



GI a GI* statistikaGI a GI* statistika  

Statistická významnost 

Z-skóre hodnoty pro úrovně (hladiny) statistické 
významnosti: 

– 90%    >= 1.645 

– 95%    >= 1.960 

– 99%    >= 2.576 

– 99.9% >= 3.291 

• Univerzální Z skóre bez ohledu na jevu, umístění, 
velikosti území… 

– Příklad: 
• Gi* hodnota = 4.1785 

• Větší než 99.9% významnost! 



Jak to udělat prakticky? Jak to udělat prakticky?   

• Conversion Tools > From Raster > Raster to Point 

• Data Management Tools > Sampling > Create Fishnet. 

– Vlastnosti identické jako v rastru (velikost buněk, rozsah)! 

• Data Management Tools > Features > Feature To Polygon 

– Propojení bodů a polygonů (Fishnet), případně použít 
Spatial Join  

• Spatial Statistics  > … > Hot Spot Analysis (Getis-Ord Gi*) 

 

 



Statistická významnostStatistická významnost  

• Finální výsledky zobrazující statistické výsledky na 
hladině významnosti 95 % (vlevo) a 99 % (vpravo). 



Statistická významnostStatistická významnost  

• Jak zlepšit zacílení 
na významné 
oblasti? 

• Testovat statistickou 
významnost jen na 
nejvyšších hodnotách. 

• Kombinovaný postup, 
z výsledku jádrového 
vyhlazení vybereme 
jen 20 % nejvyšších 
hodnot a z těchto 
hodnot vybereme jen 
statisticky významné 
výsledky metodou 
Gi*. 

 

 



  
POSTPROCESSING A POSTPROCESSING A 

VIZUALIZACE VIZUALIZACE   

• Vizuální omezení – podpora rozhodování dle 
zadání a uživatelské skupině. 

Plná data 10% nejvyšších hodnot 



Vizualizace Vizualizace ––    
„alternativní“„alternativní“  

• Metody zobrazení 

– Vícebarevné 

– 3D 

– Izolinie  

• Škály 

• Podklad 

– Topografická mapa 

– Ortofoto 

– … 



Vizualizace Vizualizace ––    
empirické testováníempirické testování  

• Nétek & Slezáková (2018): Implementation of Heat Maps in 
Geographical Information System – Exploratory Study on Traflc 
Accident Data. https://doi.org/10.1515/geo-2018-0029  

– Most of the users chose bright colors with a negative feeling, such as 
red, for traffic accident visualization. 

– The best settings for transparency was identified to be around 50%. 

– The final questions were about map readability based on radius. 
This setting is tied to mapscale but follows a common trend 
throughout the research. 

https://doi.org/10.1515/geo-2018-0029
https://doi.org/10.1515/geo-2018-0029
https://doi.org/10.1515/geo-2018-0029
https://doi.org/10.1515/geo-2018-0029
https://doi.org/10.1515/geo-2018-0029


Ještě jeden příklad… Ještě jeden příklad…   

• John Snow (1812 – 1858)  

– Syn farmáře, asistent 
chirurga a lékárník  

– 1854 – mapa Londýna 

• výskyt cholery = úmrtí 

• Měřítko 1:2000 

• Tečková metoda 

• Pomocí prostorové 
analýzy došlo k 
identifikaci ohniska 
nákazy, které bylo možné 
následně omezit  



Ještě jeden příklad… Ještě jeden příklad…   

 



Ještě jeden příklad… Ještě jeden příklad…   

 



Ještě jeden příklad… Ještě jeden příklad…   

 



Ještě jeden příklad… Ještě jeden příklad…   

 



Zdroje:  Zdroje:    

• https://gistbok.ucgis.org/bok-topics/kernels-and-density-estimation  

• https://gistbok.ucgis.org/bok-topics/point-pattern-analysis  

• Ivan, I., Horák, J. (2015): Metodika identifikace anomálních lokalit 
kriminality pomocí jádrových odhadů. Dostupné z:  
http://gisak.vsb.cz/GIS_Ostrava/GIS_Ova_2016/sbornik/papers/gis
2016568b7fa9bf442.pdf  

• Materiály předmětu Z6101 Základy geostatistiky 

• A odkazy přímo na slajdech  
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